Multi-User Guide and Networks

Networking WinTOTAL

WinTOTAL has been designed to run in a multi-user environment. Implemented properly, the benefits gained by sharing data, consolidating resources and centralizing management of the system are enormous.

a la mode has produced a video on Networking and Multi-User Installations. There’s something in it for everyone from beginners to experienced network users. Call 1-800-ALAMODE to order one today!

Network Installation

Pre-installation setup

- **Decide upon a server:** First, you will need to select which machine is going to be used as the “server”. If you have a dedicated server (a machine which is not used by anyone directly for running applications like WinTOTAL), this is the obvious choice. If you do not have a dedicated machine available, select one of the computers on your network to be your server. For better performance in WinTOTAL, it is highly recommended that you use a dedicated server.

- **Map the network drive:** WinTOTAL requires logical drive mapping to function properly. This means that network drives that are to be used for WinTOTAL need to be mapped as physical drives, (For example, F:\) instead of a virtual drive (For example, \Server\Share\Drive_C). *If you need assistance with basic Windows networking, you will need to contact a local network technician.*

It is vital that all workstations on the network “see” the server drive as the same drive letter (For example, F:\). Before mapping the drive for WinTOTAL, check all workstations to make sure that same drive letter is available on each. Any letter can be used as long as it does not represent a drive that already exists on one of the workstations.

Installing WinTOTAL on a network

If you are on a network, you can install WinTOTAL to the server from any workstation that has access to the networked drive. You don't have to be sitting at the server to run the installation. In fact, if you are using a dedicated server, it’s better if you don’t install directly to the server.
When prompted for the drive and directory for WinTOTAL, simply replace the default of C:\WIN2000 with F:\WIN2000 or another directory on your network. The installation program will automatically add Windows shortcuts to your Start Menu.

To set up WinTOTAL on the workstations, do the following:

1. Click the Start button, and then select Run.
2. Type F:\WIN2000\WIN2000.EXE and click OK. Remember to substitute the correct drive letter and path for your server in the above command.
3. The Setup Wizard will appear. Follow the instructions on-screen to complete the installation on the workstation.

Our program is smart enough to detect whether or not WinTOTAL has ever been run from that workstation and will set up all the icons and necessary files. Repeat these steps for each workstation on your network. Once this is done, all workstations will have shared access to all of the files, databases, and images that are on the server.

Using a dedicated server

We strongly recommend a system with a dedicated server. Even if your network is “peer to peer”, there’s nothing that says the server can’t be treated as dedicated.

In theory, you should be able to use a network server as a workstation. But in practice, we’ve seen it cause major network slowdowns and general unreliability when the server tries to handle requests from its own console and through the network.

Setting up user profiles

User profiles handle personal settings and more importantly - file locking. If two people are logged into WinTOTAL with the same profile, you risk them opening the same file without warning. When two people open the same report simultaneously, the result is always errors and data loss. Each machine must log in with its own profile.

To set up user profiles, do the following:

1. From within a report, click on the Tools menu, and then select Configure. From the WinTOTAL Configuration Options screen, select the User tab.
2. You’ll see the user names you have established displayed. The current user will be highlighted. To change users, click Set User.

3. You should see a profile for every person on your network. If no profile names appear, click the Add button to create new profiles.

   - *Notice the option labeled Use this name automatically in the future.* This option exists so that people aren’t prompted every time they start the program. On a network, we recommend a network administrator set up user profiles for every person through this dialog. Then, go to each machine and switch to the individual profile - enabling this option so there is no confusion in the future.

   - *Note: After you change the user name, your QuickList comments may change.* You can switch back to another QuickList profile by selecting the Change TextDB name item in the Edit menu.

**Common Installation Mistakes**

Although networking the WinTOTAL software is fairly simple, there are a few things that should be avoided to ensure your installation works properly when implemented:

   - **Do NOT map the network drive to the Win2000 folder in Network Neighborhood:** This is a common practice of many network technicians attempting to increase security. Doing this, however, will make some functions of the program inoperable. Be sure to map the network drive one level above the Win2000 folder so that the path appears similar to this: F:\WIN2000

   - Make certain that ALL permissions are given to each user on the Win2000 folder and everything inside: Another common practice of network technicians for security purposes is to only assign the “necessary” permissions to users. While this may not affect most other programs, when using WinTOTAL, every user will be reading data from the folders, writing to and creating new files and folders, and even deleting files and folders on a daily basis. This is the nature of the program.

   - Make certain to run the WINTOTAL.EXE file from the mapped drive (F:\), NOT through Network Neighborhood: Once the drive is mapped, be sure to use that drive letter, rather than Network

---

In a network environment, you should be certain that every user has their own profile for WinTOTAL. This will help to prevent database lockups and loss of data.
Neighborhood to start the program. If this is not done properly, the program will still be running through a virtual path, and you may experience errors when trying to load the program such as “Invalid Zip Argument” or “There are currently 0.00 Megabytes of free space available...”.

Recovering from an Improper Installation

If you (or your technician) have followed the guidelines on the previous pages, WinTOTAL should run efficiently across all workstations on your network. But, what if the installation was not done according to these guidelines? You will want to rectify this as soon as possible.

There are three main “Improper Installation” types:

• WinTOTAL being run through a virtual path
• WinTOTAL installed on multiple machines on the network
• WinTOTAL installed on a workstation, instead of the server

Each of these installation types brings along its own set of problems, and has its own resolution.

Using a Virtual Path

Explanation of a virtual path

As we’ve said before, WinTOTAL requires logical drive mapping to function properly. This means that network drives that are to be used for WinTOTAL need to be mapped as physical drives, (For example, F:\) instead of a virtual drive (For example, \Server\Share\Drive_C).

It is recommended that all workstations on the network “see” the server drive as the same drive letter (For example, F:\). Before mapping the drive for WinTOTAL, check all workstations to make sure that same drive letter is available on each. Any letter can be used as long as it does not represent a drive that already exists on one of the workstations. Consult your Network Administrator or a local technician for assistance with mapping a network drive.
Resetting WinTOTAL to run from the mapped drive

Once the drive is mapped, the contents of the ALAMODE.INI file that hold settings regarding directories must be cleared so that WinTOTAL can re-assign them properly.

1. At the workstation, click the **Start** button, and select the **Run** icon.
2. In the **Open** dialog, type **COMMAND**, and then click **OK**.
3. This will open an MS-DOS window with a blinking cursor in the top, left-hand corner. At the prompt, type:

   ```
   REN  %WINDIR%\ALAMODE.INI  ALAMODE.OLD  (Press Enter)
   ```

   *Note: If you have any shortcuts on your desktop pointing to WinTOTAL, delete them now. They will be pointing to the wrong location.*

   Next, you will need to reset the icons you use to run WinTOTAL and point them to your server. Here’s how:

4. At the workstation, click the **Start** button, and select **Run**.
5. In the **Open** line, type **F:\WIN2000\WIN2000 INSTALL** and then click **OK**.

   If your server drive is not **F:\**, substitute the appropriate drive letter in the above command.

   The Setup Wizard will appear. Follow the on-screen instructions to complete the installation. When the installation is finished, it will create new icons in your Start menu. Use these icons to start WinTOTAL, and the program should open error free.

Multiple Local Installations

**Explanation**

This is possibly the most problematic type of improper installation you may encounter. Because the program is being run locally, all of the files, databases, images, etc. are most likely being loaded from each individual machine, isolating each workstation from everyone else, and not allowing anyone to benefit from other users’ efforts.

In order to resolve this kind of configuration, you will need to combine all of the local installations onto a single server machine. While this process will safely retain all of your report files and user configurations, doing this...
Multi-User Guide and Networks

may cause some users on your network to lose some of their database entries (text, images, comps, etc.). This is a direct result of having local copies of the program installed in a network environment.

This process is not supported by a la mode’s Technical Support staff, and a la mode is not responsible for any data lost when following the steps below. If you are uncomfortable with completing any of these steps, you should contact a certified technician in your area for further support.

Migrating from multiple local installs

Merging multiple installations to one server requires the following:
1. Installing the WinTOTAL program to the server
2. Reconfiguring the workstations to run from the server
3. Saving user configurations to the server
4. Copying the “best” text database to the server
5. Moving the report files to the server
6. Copying/Rebuilding the comps and images databases to the server

Step 1 - Installing the WinTOTAL program to a single server

This step should be done according to the instructions set forth in the first four pages of this chapter.

Step 2 - Reconfiguring the workstations to run from the server

The following procedures will keep your workstations from running their local copies. Replace the appropriate drive letters for your network where necessary:
1. At the workstation, click the Start button, followed by Programs, and the WinTOTAL program group, and then the Tech Support Assistant icon.
2. Click the Editor button in the top, right-hand corner of the a la mode Technical Assistant window.
3. Once in the Edit System Files window, click the button labeled Find/Replace.
4. In the line labeled Find What, type C:\WIN2000. In the line labeled Replace With, type F:\WIN2000. Then click the Replace All button.
5. Click **Exit** to exit the *Edit System Files* window, and then click **Done** to exit the *Tech Support Assistant*.

   Note: If you have any shortcuts on your desktop pointing to WinTOTAL, delete them now. They will be pointing to the wrong location.

Next, you will need to reset the icons you use to run WinTOTAL and point them to your server. Here’s how:

6. At the workstation, click the **Start** button, and select **Run**.

7. In the field labeled **Open**, type `F:\WIN2000\WIN2000_INSTALL` and click **OK**.

   *If your server drive is not F:\, substitute the appropriate drive letter in the above command.*

8. The Setup Wizard will appear. Follow the on-screen instructions to complete the installation.

Repeat the steps above for each workstation on your network.

**Step 3 - Saving user configurations to the server**

Now that you have configured the workstations to run WinTOTAL from a single copy on the server, you will want to copy your user settings from each local computer to the server. These settings include your common response database and putting your user name on the list of users. Here’s how to do this:

Note: If the same user name is set up on more than one local copy of WinTOTAL, you may overwrite user settings on the server. This is a direct result of having local copies of the program installed in a network environment. a la mode, inc. is not responsible for loss of data when following these instructions.

1. At the workstation, click the **Start** button, and select the **Run** icon.

2. In the **Open** dialog, type `COMMAND`, and then click **OK**.

3. This will open an MS-DOS window with a blinking cursor in the top, left-hand corner. At the prompt, type:

   ```
   XCOPY C:\WIN2000\USERS F:\WIN2000\USERS /E /Y
   (Press ENTER)
   XCOPY C:\WIN2000\NETWORK F:\WIN2000\NETWORK /E /Y
   (Press ENTER)
   ```

Click **Replace All** to remove any references in this WinTOTAL configuration file to the installation on your computer.
Repeat steps 1-3 for each workstation from which you want to transfer local user settings.

**Step 4 - Copying the “best” text database to the server**

Once all of the workstations have been set up properly, you will have to make a decision. You must choose which text database you want to keep. **You will only be able to use one copy of this database on the server.** Again, this is a direct result of having multiple local copies in a network environment. For example, if there were four workstations on the network running local copies of WinTOTAL, then three of these people are going to lose their databases. We suggest using the database that contains the most entries.

The following steps explain how to copy a database from a local computer to the server.

Note: All users must exit WinTOTAL before moving the database to the server. Again, these steps assume that WinTOTAL is installed to F:\WIN2000 on the network server, and C:\WIN2000 is the old local directory of WinTOTAL. If this is not the case on your network, please substitute the appropriate drive letters/paths:

1. At the workstation, click the **Start** button, and select the **Run** icon.
2. In the **Open** dialog, type \*COMMAND\*, and then click **OK**.
3. This will open an MS-DOS window with a blinking cursor in the top, left-hand corner. At the prompt, type:
   For the Residential comparables database type:
   
   C:  (Press **ENTER**)
   CD\WIN2000\DATABASE  (Press **ENTER**)
   COPY TEXTDB.MDB  F:\WIN2000\DATABASE /Y  (Press **ENTER**)
   EXIT  (Press **ENTER**)

**Step 5 - Moving the report files to the server**

The safest way to copy all of your reports onto the server is to:

- Open up the Office Manager.
- Create a new folder for your reports.
Attach an external directory to the folder that contains your reports.
Use the Move/Copy command.

Using this method keeps the threat of overwriting data to a minimum, and reduces the amount of cryptic commands and procedures you would have to follow. *Again, these steps assume that WinTOTAL is installed to F:\WIN2000 on the network server, and C:\WIN2000 is the old local directory of WinTOTAL.* If this is not the case on your network, please substitute the appropriate drive letters/paths in the following instructions. Here’s how to do this:

1. Open WinTOTAL from your network installation. The Appraisal Desktop window should appear. If this does not happen, click the Open button at the top of the TOTAL for Windows window.
2. From within the Appraisal Desktop, click the Options menu at the top of the window and select Attach Directory from the drop-down list.
3. The Attach Directory dialog will appear, displaying a directory tree of all available drives and folders available from your computer.
4. Browse to the drive or folder you wish to attach as a folder within the Appraisal Desktop.

Example: if your reports are on drive C:\ in the folder called URAR, you would want to select the C:\ drive and double-click on the WIN2000 folder, then the Files folder, and then the URAR.FLD directory.
5. Click OK to attach the directory. The Appraisal Desktop will prompt you for a name for the attached directory. By default, it will use the path of the directory. However, you can name it whatever you wish. Click OK when you’ve named the folder.

The Appraisal Desktop will show the attached directory with a 'computer' icon. Treat that directory just as if it were another folder in the Appraisal Desktop. Now either create a new folder for your reports, or select an existing folder from the Appraisal Desktop. After that, all you need to do is copy the reports from the attached directory to the folder that you have selected.

6. Highlight the attached directory you created in steps 1-5.
7. Click on the first report, hold down the **SHIFT + CTRL + END** keys on your keyboard. This will highlight the entire group of report files.

8. Click on the button marked **Move/Copy** at the top of the Appraisal Desktop window.

9. The **Select Folder** dialog will appear, displaying a list of the folders on your Appraisal desktop.

10. Double-click on the folder name you selected above.

11. Repeat steps 1-10 for each folder that contains reports that need to be copied from your local hard drive to the server.

12. After copying all of these files, you should disconnect each of the attached directories to prevent any confusion. To do this click once on the **attached directory** you created in steps 1-5 above to highlight it, and then click the **Folder** menu and select **Delete**. **Note:** The folder still exists, you're simply “hiding” it from view.

Be sure that the confirmation window asks if you want to disconnect, and click on Yes.

**Note:** If you select a folder instead of the attached directory, you may delete your reports and be unable to recover them.

**Step 6 - Creating shared comps and images databases**

This step involves your making a decision. You can either:

- **One** - Start brand new, empty databases, and then let WinTOTAL automatically rebuild the databases for you from your reports. This option will completely rebuild both your comps and your images databases with information that is already contained in your reports. The only drawback to doing this is that, any images or comparables that have never been used in any report will not be added to your new databases. This is the preferred option, as it is faster and more effective.

- **Two** - Copy your images and/or comps databases from one of your workstations to the server. This option will give you databases that are already populated with information, but it will only be from one of the workstations on the network. You will be giving up any other database information stored on other workstations. You should use this option only if you have been manually entering several 

---

**By using basic Windows keyboard commands, or keyboard and mouse combinations, you can select multiple entries at one time to move to your new Office Manager folders.**

- **SHIFT+CTRL+END** selects everything from the entry highlighted to the last entry in the list.
- **SHIFT+Click** selects everything between the entry highlighted and the entry you click on.
- **CTRL+Click** individually selects multiple items in a list with each click.
comparables/images that have not been used in any of your reports. If you wish to use this method, skip to “Option #2: Copying a comps and/or image database to the server” on page 12.

Option #1: Importing images and comps from reports

To begin the import process, do the following:

1. Start WinTOTAL - it should be running from your network drive now.
2. Open a report in WinTOTAL (it doesn't matter which report).
3. Click the PowerViews menu, then select Comps PowerView.
4. In the Comps PowerView window, click the Open Database button to load the comps Database.
5. In the WinTOTAL - comps Database window, click the Insert button at the top.
6. In the Import Comparables window, first make sure that the option labeled Import photos with comps under the Additional Import Information section has a checkmark next to it.
7. Under the Office Manager Folders section, you will see a list of all folders that are available in your Office Manager. Select the folder(s) which contain(s) your reports and click the Mark button to the right. You will notice a small, red check mark applied to each folder you mark in this way.
8. Once you have marked all of the folders you need, click the OK button in the top, left corner of the dialog.

WinTOTAL will then begin importing all of the comparables that are in each of the reports stored in the Office Manager folders you have marked. At the same time, it will extract a copy of each comparable's photo from the reports and add it to your images directory and Image Database.

During this process, you may be prompted for additional comparable information. While this information is not required, it will help to keep your Comparable Database as complete as possible. You may also be presented with dialogs that indicate that a Duplicate Comparable was found. When a comparable in one of the reports matches one that is already in your database, you are given four options:

- **Add** a second copy of the same comparable to the database

Be sure that this dialog appears when you Delete your attached directory. If you are not prompted to “disconnect”, you may be deleting one of your main Appraisal Desktop folders, and all of the reports it contains.
Multi-User Guide and Networks

- **Update** the comparable in the database with the information found in the report
- **Skip** the duplicate comparable found
- **Cancel** the importing process

Once the import process is complete, you will be able to place your comparables into reports directly from WinTOTAL’s Comparables Database, and the image(s) associated with it will be placed on the appropriate form automatically.

**Option #2: Copying a comps and/or image database to the server**

For this procedure, you will need to choose which copy of the databases you want to keep. You will only be able to use one copy of these databases on the server. Again, this is a direct result of having multiple local copies in a network environment. This step is divided into three sections:

- Copying your “best” comps/images database to the server.
- Copying your images to the server.
- Modifying the images database to track your images in their new location.

**Copying your “best” comps/images database to the server**

Note: All users must exit WinTOTAL before moving the database to the server. Again, these steps assume that WinTOTAL is installed to F:\WIN2000 on the network server, and C:\WIN2000 is the old local directory of WinTOTAL. If this is not the case on your network, please substitute the appropriate drive letters/paths:

1. At the workstation from which you want to copy the comps/images database, click the **Start** button, and select the **Run** icon.
2. In the **Open** dialog, type **COMMAND**, and then click **OK**.
3. This will open an MS-DOS window with a blinking cursor in the top, left-hand corner. See the table on the right for the proper commands to move your database files.

**Copying your images to the server**

Here are the steps that need to be taken to copy the images from your local hard drive to the server. **If there are images on the server with the image(s) associated with the comparable you are importing**, you will need to follow these steps to ensure that the images are correctly placed on the appropriate form.

The Import Comparables dialog includes several options for how to import your data. **For the fastest import, leave only the box for Import photos with comps selected. If you want to be thorough with your data entry, make sure that the Prompt for additional comp information for every comp found option is selected. It is recommended that you leave the option labeled Search for duplicate comps in the database selected so that you don’t have several copies of the same comparable in your database.**
same file names as on workstations, you will be prompted whether to overwrite the file. We would recommend renaming the image files on each workstation so that the names are unique. While this will preserve every image, it will make entries to your image database invalid. The renamed images will not be found in the database.

As mentioned before, this is a direct result of having multiple local copies in a network environment (and in violation of the licensing agreement). a la mode is not responsible for loss of data following these instructions.

Note: These steps assume that F:\WIN2000 is the directory of the network install and C:\WIN2000 is the old local directory of WinTOTAL. Please substitute the appropriate drive letters in the following instructions.

1. At the workstation, click the Start button, and select the Run icon.
2. In the Open dialog, type COMMAND, and then click OK.
3. At the DOS prompt, type:
   COPY C:\WIN2000\IMAGES\*.*  F:\WIN2000\IMAGES
   (Press ENTER)
   EXIT (Press ENTER)
Repeat steps 1-3 on each workstation.

Modifying the images database to find your images in their new location

Once the databases and the images have been moved, you will need to modify the images database in order to find the images in their new location. To do this requires that you open the database in the VisualData program included with WinTOTAL to modify the list of folders used in the database.

Once again: a la mode cannot support this procedure, and is not responsible for any data lost as a result of modifying your database. If you are uncomfortable modifying your image database, you should contact a local technician to make the appropriate changes.

These steps assume that F:\WIN2000 is the directory of the network install and C:\WIN2000 is the old local directory of WinTOTAL. Please substitute the appropriate drive letters in the following instructions.

For the Residential comps database type:
C: (Press ENTER)
CD\WIN2000\DATABASE (Press ENTER)
COPY RESCOMPS.MDB  F:\WIN2000\DATABASE /Y (Press ENTER)
EXIT (Press ENTER)

For the Commercial comps database type:
C: (Press ENTER)
CD\WIN2000\DATABASE (Press ENTER)
COPY CMRCOMPS.MDB  F:\WIN2000\DATABASE /Y (Press ENTER)
EXIT (Press ENTER)

For the images database type:
C: (Press ENTER)
CD\WIN2000\DATABASE (Press ENTER)
COPY W2IMAGES.MDB  F:\WIN2000\DATABASE /Y (Press ENTER)
EXIT (Press ENTER)
The following steps will edit the database to point to the new image location:

1. At the workstation, click the Start button, and select the Run icon.
2. In the Open dialog, type F:\WIN2000\VISDATA, and click OK to start the Visual Data application.
3. Inside Visual Data click the File menu, choose Open Database and then MS Access.
4. In the Open MS Access Database window, under the Folders heading in the middle, scroll down and double-click the Database folder.
5. Under the File name section, scroll to the file named W2IMAGES.MDB. Click on that file once to highlight it and click the OK button.
6. With the W2IMAGES.MDB database open, you will see the Tables/Queries: window with two selections: Folders and Images. Click once on Folders to highlight it and click Open.
7. Now, inside the Table: Folders window, click the Edit button.
8. The FILEPATH can now be edited to point to the new location of the images.
   (Example: if the images have been moved from the C: drive to the F: drive, the path would be changed from C:\WIN2000\IMAGES to F:\WIN2000\IMAGES.)
9. With the path changed to reflect the new path, click the Update button.
   Note: This will bring you back to the previous window. If there are multiple records that need to be edited, click on the button to take you to the next record, and repeat steps 7 through 9 for each record.
10. Once you’ve updated all of the necessary records in the Table: Folders window, click the Close button.
11. Now click the File menu and choose Exit.
   Your images database should now be able to find all of the images on your network server.
   That’s It
Once you’ve completed the above steps on all of your workstations, your network should be configured for maximum efficiency.

Moving From a Local Install to a Shared Server

Explanation
This type of installation happens for a variety of reasons. Commonly, one person will have the program installed, when the company determines it would be beneficial to network several computers together. In this case, many times, a one computer becomes designated as the server (usually not the same computer where WinTOTAL is already installed), and everyone wants to run the WinTOTAL program from the server.

To move a single installation of WinTOTAL from one workstation to a server, you will need to first move all of the program and data files over, and then, you will need to modify the image database to locate your images in their new location.

Moving the program and data files to the server
There is a simple DOS command you can use to copy the WinTOTAL directory from one hard drive to another. Before you begin, though, read the section of this document devoted to backing-up your files. Backing up is mentioned simply as a precaution, and is not a requirement. It does however, insure that you will always have a copy of your reports, and it can ease the process of restoring WinTOTAL to the new hard drive.

1. At the workstation, click the Start button, and select the Run icon.
2. In the Open dialog, type COMMAND, and then click OK.
3. This will open an MS-DOS window with a blinking cursor in the top, left-hand corner. At the prompt, type:

   MD F:\WIN2000 (Press ENTER).

   Note: If your server drive is not F:, replace F: with the appropriate drive letter in the above commands.

   Your only other concern at this point is to adjust the ALAMODE.INI in the C:\WINDOWS directory. This file contains all the paths WinTOTAL uses

   Be sure to change the FILEPATH to point to the new location in which your images are stored.

   If there are multiple records, make certain that you have updated all of them before exiting the Visual Data application.
to access your reports, text database comments, and images, among other things. To do this, do the following:

4. At the workstation, click the **Start** button, followed by **Programs**, and the **WinTOTAL** program group, and then the **Tech Support Assistant** icon.

5. Click the **Editor** button in the top, right-hand corner of the *a la mode Technical Assistant* window.

6. Once in the **Edit System Files** window, click the button labeled **Find/Replace**.

7. In the line labeled **Find What**, type `C:\WIN2000`. In the line labeled **Replace With**, type `F:\WIN2000`. Then click the **Replace All** button. Click **Exit** to exit the **Edit System Files** window, and then click **Done** to exit the **Tech Support Assistant**.

   Note: If you have any shortcuts on your desktop pointing to WinTOTAL, delete them now. They will be pointing to the wrong location.

Next, you will need to reset the icons you use to run WinTOTAL and point them to your server. Here's how:

8. At the workstation, click the **Start** button, and select **Run**.

9. In the **Open** line, type `F:\WIN2000\WIN2000  INSTALL` and then click **OK**.

   If your new drive is not `F:\`, substitute the appropriate drive letter in the above command.

10. The Setup Wizard will appear. Follow the on-screen instructions to complete the installation.

Once you are sure that WinTOTAL is functioning properly on the new hard drive, you can delete the old WIN2000 directory on the C:\ drive.

**Modifying the image database to find images in their new location**

When you download pictures through QuickPix, an entry is written to the image database that tracks where those images are stored on your hard drive (e.g. `C:\WIN2000\IMAGES`). If you move those images to a new hard drive or directory (`D:\` or `E:\`), the database will still look for the images in the original location marked in the database. This is one of the reasons for having the new hard drive installed as the C: drive and
copying WinTOTAL over to it. When moved to another C: drive all that changes is the available disk space.

Once the databases and the images have been moved, you will need to modify the images database in order to find the images in their new location. To do this requires that you open the database in the Visual Data program included with WinTOTAL to modify the list of folders used in the database.

a la mode cannot support this procedure, and is not responsible for any data lost as a result of modifying your database. If you are uncomfortable modifying your image database, you should contact a local technician to make the appropriate changes.

These steps assume that D:\WIN2000 is the directory of the new/network install and C:\WIN2000 is the old local directory of WinTOTAL. Please substitute the appropriate drive letters in the following instructions.

The following steps will edit the database to point to the new image location:

1. At the workstation, click the Start button, and select the Run icon.
2. In the Open dialog, type F:\WIN2000\VISDATA, and click OK to open Visual Data.
3. Inside Visual Data click the File menu, choose Open Database and then MS Access.
4. In the Open MS Access Database window, under the Folders heading in the middle, scroll down and double-click the Database folder.
5. Under the File name section, scroll to the file named W2IMAGES.MDB. Click on that file once to highlight it and click the OK button.
6. With the W2IMAGES.MDB database open, you will see the Tables/Queries: window with two selections: Folders and Images. Click once on Folders to highlight it and click Open.
7. Now, inside the Table: Folders window, click the Edit button.
8. The FILEPATH can now be edited to point to the new location of the images.

Click Replace All to remove any references in this WinTOTAL configuration file to the installation on your computer.
(Example: if the images have been moved from the C: drive to the D: drive, the path would be changed from C:\WIN2000\IMAGES to D:\WIN2000\IMAGES.)

9. With the path changed to reflect the new path, click the Update button.

Note: This will bring you back to the previous window. If there are multiple records that need to be edited, click on the button to take you to the next record, and repeat steps 6 through 8 for each record.

10. Once you've updated all of the necessary records in the Table: Folders window, click the Close button.

11. Now click the File menu and choose Exit.

Your images database should now be able to find all of the images on your network server.

General Questions

When would I need a network? Can't I just install WinTOTAL on all of the computers in my office?

If you have several people in your office needing to run WinTOTAL at the same time, then you should get a network.

- Even though the WinTOTAL installation disks are not copy protected, it is against our licensing agreement to run it on two separate computers at the same time; therefore, you can not legally install it on several computers for several appraisers to use simultaneously. Think of it like a book: Two people can't read a book in two places at the same time.

- If you have several appraisers in your organization with separate PC's, you should either network those PC's or buy additional WinTOTAL licenses from a la mode. Our technicians are authorized to not support your program if we know it's on multiple PC's.

In plain terms, this sounds kind of rough, but it is actually very standard for all types of software. When you consider the fact that we don't charge extra for the network capabilities as our competitors do and that extra licenses are at a greatly reduced price, it's very reasonable and lenient.
What's the difference between installing WinTOTAL on a network server and on separate PC's?

When WinTOTAL is on a network server, then all of the program files, forms, databases and program settings are in one location. It's very convenient for you by allowing you to share your data with other appraisers in the office, thereby saving time and effort. It also keeps all billing and management features centralized and convenient.

Another benefit to networking is that it makes technical support easier, since we can trace any problems down to one location. For example, if a function works as intended on workstation and not another, it can be logically deduced that there is nothing wrong with the WinTOTAL program files. Our technicians then know to look for things like device drivers that can change from workstation to workstation.

Can WinTOTAL be installed to the local “C” drive with simply the files directory pointing to the network?

Absolutely not! In order for Appraisal Desktop functions to work properly - specifically, keeping the various entries for appraisers, lenders and clients accurate - WinTOTAL needs to be run from the network server. The lookups for appraisers, lenders and clients are stored in the program directory. This is required in order to make a comprehensive billing module work.

When a data file is opened, WinTOTAL checks to see if it was created on the same system. (It uses your customer number.) If so, it matches the ID codes for the appraisers and clients with those in the program directory. Therefore, if you have multiple local installations using the same customer number sharing only a common data directory, you risk getting erroneous data in your appraiser and client fields.

Installing WinTOTAL on several “C” drives in a networked office is also in violation of our License Agreement and nullifies your support contract. (Have we convinced you not to do this yet?)

Do I need a special version of WinTOTAL if I plan to run it on a network? Does WinTOTAL run differently on a network?

No. We took extra steps to make WinTOTAL a multi-user program right out of the box. WinTOTAL always loads user configuration files when
you start it so that it can retain settings for each profile. On a stand alone system, there is typically just one configuration file.

More Chapters

Click here to go to the online Table of Contents where you can access additional chapters in the WinTOTAL user guide. Or, view the other parts of the manual by selecting Contents from WinTOTAL’s Help menu. You will find more tutorials on all of WinTOTAL’s PowerViews. The more you know about the software, the more efficient and competitive you can be.
The Print Manager window displays the current status of any reports that are waiting to be printed.

If you want to set up a desktop shortcut to run the WinTOTAL Print Manager, be sure to use the /PRINTMAN switch in the Target line.